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Review: Generic 2-to-1 Datapath Multiplexor Entity

)

e ) o
= L — -.-'i
: T
R ———
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The file generic_mux.vhd contains:

LIBRARY IEEE; :
USE IEEE.std logic_1164.all; 2570
USE IEEE.std _logic_arith.all;
b=
ENTITY Generic_Mux IS '
GENERIC (n: INTEGER :=8); .

PORT (Y: OUT std _logic_vector(n-1 downto 0);
a IN std _logic_vector(n-1 downto 0);
b: IN std_logic_vector(n-1 downto 0);
S: IN std _logic_vector(0O downto 0)
);
END ENTITY;
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Review: Generic 2-to-1 Datapath Architecture

7 =

I
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ARCHITECTURE Generic_Mux_arch OF Generic_Mux IS
BEGIN
WITH S SELECT
Y <=aWHEN "1",
b WHEN OTHERS;
END ARCHITECTURE;

CONFIGURATION Generic_Mux_cfg OF Generic_Mux IS
FOR Generic_Mux_ arch
END FOR;

END CONFIGURATION;
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Synthesis: Debugging syntax errors
A —

il
(2

Open a host terminal #1 (or telnet) window and
Enter the generic_mux.vhd using an ascii editor:
Vi generic_mux.vhd
i --1 for insert mode

--enter code
ESC --Escape key to exit insert mode
W --write the file but do not exit

Open another host terminal #2 (or telnet) window and
start dc_shell in order to analyze vhdl for syntax errors.
dc_shell

> analyze -f vhdl generic_mux.vhd

Use the editor in host #1 to to fix the errors then write (:w)
then in host #2 type !an to reanalyze the vhdl source code
until there are no more errors.




Synthesis: Quick example of Design Compiler

= "
e

(&

Td start the design
compiler type:

analyze is required for each file
In the hierarchical design

> analyze -format vhdl -lib

. starting from the bottom up

rary WORK generic_mux.vhd

> elaborate generic_mux -arch generic_mux_arch -lib WORK -update

> |ist_designs

> uniquify
> compile
> report_cell

> write -hierarchy
> quit

Design name is entity name
generic_mux NOT the filename
generic_mux.vhd

elaborate only the top level
design and generic_mux
becomes the current design

writes out the current design
generic_mux.db and others




Viewing Results: Design Analyzer (dc_shell GUI)
A -

L2

To view .db logic gate files, type: design_analyzer&

File => Read => generic_mux.db

The system-level view is shown

double click on the generic_mux icon to see the port-view

double click on the port view icon to see the gate-level view

In order to print: File => Plot => ok

File => quit => ok
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Synthesis: Design Analyzer quick overview

)

Design_analyzer is just a GUI that is built on top of dc_shell
« Every command in dc_shell can be done with the file menu

To start the design analyzer GUI type: design_analyzer&

File=>analyze=> generic_mux.vhd => cancel

File=>elaborate=> library: click on file WORK
Design: click on file generic_mux_arch
=> ok

Click on generic_mux design icon then
Edit=>Uniquify=>Hierarchy

Tools=>Design Optimization=>0k (now click on icon to view)

File => save
File => quit
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dc_shell: analyze and elaborate
I =

(2

analyze -format vhdl elaborate generic_mux -arch
-library WORK generic_mux_arch -lib WORK
generic_mux.vhd -update

arch & config

vhd
names

o compile I
vhd directory
source JWORK
S <
~ —
Design files: contains all db

architecture and desian
configuration design names 9

extracted from the analyze ®
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dc_shell: analyze
7 e

1

[l
QH

explicit: analyze -format vhdl -library WORK filename.vh

short form: analyze -f vhdl filename.vhd

The analyze command does the following
® Reads in the VHDL source file

® Check for errors (without building any generic logic)

® Creates VHDL library objects and stores them in
-library WORK
by the default library in the “.synopsys_dc.setup” file
define _design_library WORK -path ./WORK

If analyze command reports errors then
® The VHDL source must be fixed
¢ And analyze must be run again.
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dc_shell: elaborate
7 ——

L2

explicit: elaborate entityname -architecture archname -update
short form: elaborate entityname -arch archname -update
The elaborate command does the following

® Elaborates the entity design read in by analyze (./WORK)

® Creates a technology-independent design

® Replaces VHDL arithmetic operators with
Designware components

® Generic VHDL parameters can be set or changed
elaborate ....... -parameters “N=1,Cout=2"

® Displays and sets the current design
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dc_shell: report_hierarchy, report_design

I
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» —
command: report_hierarchy [-full]
® Display the hierarchy of the current design

command: report_design

® Displays attributes of the current design, such as:
® Technology library, flip-flop types, operation conditions
® Wire load model, pin delays
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dc_shell: list and current design

|
i
Y,

command: list_designs
alternate command.: list -designs

The list -desighs command does the following

® [ists each entity design name current read or elaborated
® A star (*) preceding the design name is the current design
® lists the file name of each design

command: current_design
® Displays the current design to be compiled

command: current_design = “entityname”
® Sets the current design to “entityname”
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dc_shell: compile and design optimization
» —
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explicit: compile -map_effort medium
short form: compile

The compile command does the following

® Performs logic-level and gate-level synthesis and

® area and delay optimizations on the current design
-map_effort [ low | medium | high ]

® Specifies the relative amount of CPU time spend during
the mapping phase of the compile. The default is medium.

-ungroup_all

® Collapses all levels of hierarchy in a design, except those
that have the don’t_touch attribute set.
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dc_shell: report_cell, report_area

command: report_cell [-connection] [-verbose] [>filename.txt

® Displays information about the ASIC logic cells
In the current design

® connection shows the netlist connections between cells
® _connection -verbose shows more netlist details

® Write the data to a file: report_cell >generic_mux_cell.txt

command: report_area [>filename.tx{]
® Displays cell area information in the current design
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dc_shell: report_port, report_timing
7 —

|
(2

command: report _port [-verbose] [>filename.txt]
® Displays port informationin the current design

® -verbose gives Input and Output delays

command: report_timing
® Displays maximum delay timing in the current design

command: report_timing -delay [min|max|max_fall|max_rise]
® Displays various delay timings in the current design

command: report_timing -from <port> -to <port>
® Displays delay timing the current design
® For example: report_timing -from X0 -to F
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dc_shell: write

)

explicit: write -hierarchy -format db -output generic_mux.db

short form: write -h
The write command does the following

® Writes a design netlist or schematic from dc_shell to a file

-format [db | edif | vhdl | verlog ]

-f [db | edif | vhdl | verlog |
® Specifies the output format of the design
®*db Synopsys internal database format (default)
® edif Electronic Design Interchange Format
®*vhdl VHDL netlist based on technology files

-hierarchy or -h
® Write all designs in the hierarchy
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dc_shell: include scripts

s - . ——
command: include filename.dc_shell
® Reads in and executes the file as dc_shell commands

® Includes can contain includes and /* comments */
® Using include files is the proper way to design ASICs

L2

For example, the file generic_mux.dc_shell contains:

analyze -format vhdl -library WORK generic_mux.vhd
elaborate generic_mux -arch generic_mux_arch -lib WORK -update
report_hierarchy

uniquify

compile

[* write out reports use >> for append to file */
report_cell >generic_mux.report

report_area >>generic_mux.report

report_timing >>generic_mux.report

write -hierarchy

exit
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dc_shell: help, history, sold, list
> —

I
L;E}

command: list -commands
® Displays all the commands in dc_shell

command: history
® Display all the commands excuted in dc_shell

® The history file is the user’s directory as command.log

command: help <dc_shell command>
® Display dc_shell command help

® For example: help report_area

command: list -variables [system | compile| ... | all ]
® Displays all the variables in dc_shell

command: sold &
® Displays the adobe .pdf Synopsys OnLine Documents

® Should be started outside of dc_shell
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dc_shell: internal Unix commands
» =

|
(2

command: Is |-l ]
® Displays the current file directory
® Displays the current file directory in long format

command: cd <directory>

® Set the current directory: cd /home/users/wolff
® Set the current SHOME directory: cd

® Go up one directory level: cd ..
command: pwd
® Display the current directory
command: more filename
® Display the contents of a file: more generic_mux.vhd

command: sh <Unix command>
® Executes Unix shell commands outside dc_shell: sh ps
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dc_shell: Creating a Design Environment

I
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- =
The following steps are required to setup a design
environment (note ~ is the user’s home directory):

(1) Make sure your Unix account uses cshell
Otherwise everytime after you login & use synopsys: csh

(2) create a directory, say: mkdir ~/SYNOPSYS

(3) create a work directory: mkdir ~/SYNOPSYS/WORK
(4) copy the startup shell file: cp /home/users/wolff/.cshrc ~
(5) copy the Synopsys setup files:

cp /home/users/wolff/SYNOPSYS/.synopsys_dc.setup ~/SYNOPSYS
cp /home/users/wolff/SYNOPSYS/.synopsys_vss.setup ~/SYNOPSYS

(6) Re-login to your Unix account
(7) Enter into your design directory: cd SYNOPSYS
(8) Start the Synopsys tool: dc_shell
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dc_shell: .synopsys _dc.setup
» —

I
L;E}

Both dc_shell and design_analyzer reads the
.synopsys_dc.setup file first which contains default settings,
search paths for work and technology directories

For example, suppose that the following line is contain in the
“.synopsys_dc.setup file”

define_design_library WORK -path ./WORK

then the dc_shell command analyze
analyze -format vhdl -library WORK generic_mux.vhd

can be now accomplished without the -library WORK option:

analyze -format vhdl generic_mux.vhd

CWRU EECS 317



dc_shell: .synopsys _dc.setup example
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[* For example, “.synopsys_dc.setup file” */
[* design_analyzer=>setup=>defaults: shows these 6 items */
company = “Case Western Reserve University”

designer = “Francis G. Wolff”

[* directory search paths for target, link, and symbol libs */
search_path ={. ./WORK /home2/synopsys/2000.05/libraries/syn }
link_library ={ class.db }

target_library ={ class.db }

[* symbol library contains graphical logic symbols */
symbol_library ={ class.sdb Isi10Ok.sdb generic.sdb }

plot_ command “lpr -Polin404”

define_design_library WORK -path ./WORK

[* design_analyzer=>view=>style: don’t show net or pins */
net _name_layer.visible = “true”

pin_name_layer.visible = “false”
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dc_shell: .synopsys vss.setup example
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7 =

WORK >DEFAULT
DEFAULT : ./WORK
TIMEBASE =ns

CWRU EECS 317



dc_shell: cshell user environment: .cshrc example

&

set history=300 savehist=300

set path=( . /usr/ucb /bin /usr/bin /usr/local/bin /usr/ccs/bin )

set path=( ${path} /usr/local/shin /usr/sbin /shin )

set path=( ${path} /usr/bin/X11 /usr/X/bin /usr/X/demo )

# solaris paths

set path=( ${path} /usr/dt/bin /usr/openwin/bin /usr/dt/appconfig/netscape )

umask 077

set prompt="cshell-${user}@ hostname":${cwd}> "
setenv TERM vt100

setenv PRINTER olin404

if( ${?prompt} ) then
alias setprompt 'set prompt = "cshell-${user}@ hostname":$cwd> "'
alias cd 'cd \!* ; setprompt’
alias pushd 'pushd \I* ; setprompt'
alias popd 'popd \!* ; setprompt'
setprompt
endif
# required by g++ compiler, runtime sharable libraries

setenv LD _LIBRARY_PATH /usr/local/lib:/usr/local/X11/lib:/usr/local/lib/X11
setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:/usr/dt/lib:/usr/openwin/lib

# require by make CC default
setenv CC /usr/local/bin/gcc

setenv LM_LICENSE_FILE 27000@jupiter.ces.cwru.edu
setenv SYNOPSY'S /home2/synopsys/synthesis

if -d $SYNOPSYS then
source $SYNOPSY S/admin/setup/environ.csh
# Synopsys Online Documentation: sold
set path = ( ${path} ${SYNOPSYS})
set path = ( ${path} ${SYNOPSYS}/${ARCH}/bin)
set path = ( ${path} ${SYNOPSYS}/${ARCH}/license/bin )
setenv MANPATH ${MANPATH}:${SYNOPSY S}/doc/license/man

)

I
2.

’

# design_analyzer, dc_shell, fpga_shell, bc_shell
set path = ( ${path} ${SYNOPSY S}/${ARCH}/syn/bin )
setenv MANPATH ${MANPATH}:${SYNOPSY S}/doc/syn/man
setenv MANPATH ${MANPATH}:${SYNOPSY S}/doc/pt/man
# designware
set path = ( ${path} ${SYNOPSY S}/${ARCH}/dware/bin )
set path = ( ${path} ${SYNOPSY S}/${ARCH}/pc/bin)
setenv MANPATH ${MANPATH}:${SYNOPSY S}/doc/pc/man
setenv MANPATH ${MANPATH}:${SYNOPSY S}/doc/motif/man
setenv SIMWAVEHOME ${SYNOPSY S}/${ARCH}/ssi
set path = ( ${path} ${SYNOPSY S}/${ARCH}/ssi/bin )
set path = ( ${path} ${SYNOPSYS}/${ARCH}/vhmc/bin )
echo ".cshrc information: $SYNOPSY'S is mounted"

else
echo ".cshrc warning:  $SYNOPSYS is not mounted"

endif

setenv SYNOPSYS_SIM /home2/synopsys/simulation
if -d $SYNOPSYS_SIM then
# vhdlan, vhdldbx, vhdlsim (event-based simulators)
source $SYNOPSYS_SIM/admin/setup/environ.csh
echo ".cshrc information: $SYNOPSYS_SIM is mounted"
# Setup environment for Cyclone RTL cycle-based simulator
#
#source $SYNOPSY S/admin/setup/snps_cy.setup

else

echo ".cshrc warning:  $SYNOPSYS_SIM is not mounted"
endif
alias IsIs -aF

alias m more
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Assignment #5
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)

a) Synthesize the N-bit ALU (default N=8) using the vhdl code
of assignment #4 using dc_shell. Report the area, cells and
timing information of your synthesis. Hand in the source files
and session using the Unix script command. Also, hand in
the design_analyzer logic diagrams of the 1-bit alu and the 8-
bit ALU. Remember you cannot synthesize the test bench.
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